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Files and folders



Storing data on your computer is very similar to storing documents in a filing cabinet: the more logically you file things
away, the easier it is to find them again. Most computers come with a single hard drive for storage and by default
Windows stores all your personal stuff (documents, videos, pictures and music — everything except programme files) in
the Cdrive in a folder called Users and a sub-folder with your username. The other main folders are for programmes
and for the actual operating system, Windows itself.

As an analogy, you
can think of the
hard drive as a 3-
drawer filing
cabinet with the
operating system
in the bottom
(most stable)
drawer,
programme files in
the middle drawer,
and personal data
in the “users”
drawer at the top.

The data (Users) drawer can be sub-divided into as many
compartments as necessary. If you have a single login then
that user can separate the space into different areas for
pictures, music, personal data, work data, videos or whatever,
and if there is more than one user account then each user can
do the same with his or her compartment.




File Explorer (previously called Windows Explorer) is the file management application used by Windows
operating systems to browse folders and files. It provides a graphical interface for the user to navigate and
access the files stored in the computer.

File Explorer

The main way to access the File Explorer is by clicking the folder icon in the Start Menu or on the Taskbar: if you
hover over the folder on the taskbar you should see a pop-up window saying “File Explorer”.

File Explorer
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After you click the icon, the File Explorer window will open.



The most common
view, which can be
customised or changed,
shows in the left-hand
column (outlined in
orange) all the main
parts of your computer
and anything
connected to it. The
right-hand portion of
the screen (outlined in
green) shows the
contents of the part
selected and
highlighted on the left.
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At the top of the screen you can see the File Explorer ribbon, which looks rather like the ribbon featured in Office
applications like Word and Excel. The ribbon contains buttons for common tasks for dealing with your files and folders.



The Ribbon features four tabs, each with different commands. From the Home tab you can:

* Move files and folders to another location.

e Copy files and folders to another location.

* Delete afile or folder permanently or send it to the Recycle Bin.
* Rename a file or folder.

* Create a new folder or other new items.

e Verify or modify the Properties of a document or folder.

* Open afile or folder.

* Select one or more files and folders.
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The Share tab on the ribbon gives you different options to share your files and folders, such as:

e E-mailing or messaging a file.
 Compressing (“Zipping”) a folder to take less space.
* Printing or faxing documents.

* Sharing with other users or networks.

The File tab opens a menu with different options including:

Opening an additional File Explorer window.

Opening command windows for advanced users.

Changing or configuring options about how File Explorer behaves.

: Open new window

Open command prompt

E Open Windows PowerShell
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The View tab on the ribbon allows you to change the way Windows displays your files and folders.
Some of the changes you can make here are -

Adding additional panes to show a preview or details of your files.
Changing the layout of the files and folders from icons to list, and others.
Sorting and arranging the contents of your folder.

Hiding selected folders or files.

The next few slides show how you can add and remove panes.
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Or a Details pane like this:
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You can even turn off the navigation pane (normally shown on the left):
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Once you have the number of panes you want, you can then choose how you want to display the contents
of the main area of the window by choosing from the options in the Layout section of the tab.

Share View
[ ] Extra large icons CJ Large icons & Medium-sized icons
ew pane =
98 Small icons == List = Details
ils pane 52 Tiles §E Content v

Layout

There are 8 options available, as follows:

* Icons, in one of 4 different sizes

* List

e Details

e Tiles

* Content

We’'ll have a look at these in the next few slides, and you can tell which view is shown by seeing which option
is highlighted.
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The last (and in my view best) view is Details:
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Financial and tax File folder
v 8l Network
FUNNIES File folder
> [ IM-NEWPC
games File folde
> I NAS4BDISF )
Helidays File folder
Heme improvements File folde
Home Insurance 1.21:00 File folder

Karenware folde
Miscellaneous File folder
& Music File folde
My camera File folder

40 items

This view allows you to choose what details to display for the contents of the folder.



Clicking on “Add columns” in the Current View section of the ribbon opens a dropdown menu with a few columns to
add if you want, and clicking on “Choose columns” opens another window showing all 299 (apparently: | haven’t

counted them myself!) available column headers.

| = | Documents
W ore =)
r z
&
Fa 4 B » ThisPC > Documents 3
Quick acce:

> @ OneDrive - Personal

~ Wl This PC

» [l Desktop

» | Documents

4 Downloads

» @ Music

» I Pictures

> Bl videos

» w= Local Disk (C)
v = Data (0

» [ Documents
> == Images (E)
> = Backups (F)
» = Shared (WNAS4BD18F) (¥)
v Sl Network

> I IM-NEWPC

» Il NAS4BD1BF

Access development
Backup Explorer
Book

Business

Calibre

car stuff

CoffeeCup Software
computer_stuff
Correspondence
Custom Office Templates
Cyberlink

DO NOT DELETE

L Downloads

Excel

exe files

Financial and tax
FUNNIES

games

Holidays

Home improvements
Home Insurance
Karenware

Miscellaneous

& Music

My camera

I

Sort
by

Date |
27/03
11/12

04/09

Group by ¥

Di| Add columns ~

v/ Date modified

v Type

v/ | Size
Date created
Authors
Categories
Tags

Title

Choose columns...

[ Item
File
1 Hidd|

pe

e fold

e fold

e fold

EECo&E O

Choose Details X

Select the details that you want to display for the items in this
folder.

Details:

W Move Up
Date modified I

i Type Move Down
B1p

Size

(O« Show

() 35mm focal length
D Account name
() Album

() Album artist
(JAbum ID

D Anniversary

(] Assistant's name
(] Assistant's phone
D Attachments

(] Attributes

(] Audio tracks

(] Authors

— .

Hide

Width of selected column (in pixels): 612



This means that for music tracks, for example, it is possible to display details from the metadata encapsulated
within the track when it was created such as the length, the aloum from which it came, the artist and in some
cases an image of the album cover.

Name Title Contributing artists Album Length
> Quick access
Add
> @ OneDrive - Personal
2 (Everything | Do) | Do It for You.mp3 (Everything | Do) | Do It for You Bryan Adams Anthology (disc 1) 00:06:35
v @ This PC 2] 5-15.mp3 5:15 The Who Quadrophenia (2 of 2) 00:05:01
> [ Desktop 2 17 Again.mp3 17 Again Tide Lines Eye of the Storm 00:03:28
> = Documents 2. 40 Yil- 1998 (enstrimental).mp3 40Yil Baris Manco Mancoloji CD2 00:06:23
> | Downloads 2., A Dali-Esque Sleep Fuse.mp3 A Dali-Esque Sleep Fuse Edgar Froese Stuntman 00:08:33
> 0 Music 2 A Spaceman Came Travelling.mp3 A Spaceman Came Travelling Chris de Burgh 00:05:10
> PR Pictures 2 A Whiter Shade Of Pale.mp3 A Whiter Shade Of Pale Procol Harum 00:03:59
> uVideos 2 Abraham, Martin And John.mp3 Abraham, Martin And John Marvin Gaye Motown Chartbusters V... 00:04:17
> b Local Disk (C) 2 After the Gold Rush.mp3 After the Gold Rush Neil Young After the Gold Rush 00:03:46
v == Data (D) 2 Alba.mp3 Alba Runrig Cutter and the Clan 00:04:01
E 2. Albatross.mp3 Albatross Fleetwood Mac The Pious Bird Of Good ...  00:03:13
> = Documents
> wmImages (E) 2/ Alexander MacAskill of Bernera, Harrismp3  Alexander MacAskill of Bernera, Harris  Peatbog Faeries Faerie Stories 00:07:29
2/ All Along The Watchtower.mp3 All Along The Watchtower Hendrix, Jimi Electric Ladyland 00:04:01
> wm Backups (F)
2/ All The Roadrunning.Mp3 All The Roadrunning Mark Knopfler And E...  All The Roadrunning 00:04:49
> mm Shared (\\NAS4BD18F) (Y:)
2/ all_or_nothing.mp3 All or Nothing The Small Faces Das Poparchiv 1966 00:03:04
v t Network
2 America.mp3 America Paul Simon & Art Gar.. Bookends 00:03:35
> [ JIM-NEWPC
2! An Ubhal as Airde.mp3 An Ubhal as Airde Runrig Cutter and the Clan 00:03:46

~ @@ nrnircapmaor



For photographs it is possible to display aperture and exposure data, as shown below:

>

>

v

>

>

>

>

v

>

>

Quick access
@ OneDrive - Personal

I This PC
@ Desktop
é Documents
' Downloads
0 Music
8 Pictures
u Videos
= Local Disk (C:)
== Data (D:)

> [ Documents
== |mages (E:)
== Backups (F)

== Shared (\\NAS4BD18F) (Y:)

t Network
I JIM-NEWPC

[ NAS4BD18F

Name
IMG_0774.JPG

IMG_0775.JPG
IMG_0776.JPG
IMG_0777.JPG
IMG_0778.JPG
IMG_0779.JPG
IMG_0780.JPG
IMG_0781.JPG
IMG_0782.JPG
IMG_0783.JPG
IMG_0784.JPG
IMG_0785.JPG
IMG_0786.JPG
IMG_0787.JPG
IMG_0788.JPG
IMG_0789.JPG
IMG_0790.JPG
IMG_0791.JPG
IMG_0792.JPG
IMG_0793.JPG
IMG_0794.JPG

IMG_0795.JPG

Date modified
14/04/2022 15:03

14/04/2022 15:24

14/04/2022 15:24

14/04/2022 15:26

14/04/2022 15:26

14/04/2022 15:26

14/04/2022 15:27

14/04/2022 15:27

14/04/2022 15:29

14/04/2022 15:29

14/04/2022 15:31

14/04/2022 15:31

14/04/2022 15:31

14/04/2022 15:32

14/04/2022 15:33

14/04/2022 15:35

14/04/2022 15:35

14/04/2022 15:36

14/04/2022 15:36

14/04/2022 15:38

14/04/2022 15:57

14/04/2022 15:57

Type
JPG File

JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File
JPG File

JPG File

Size

7,096 KB

10,658 KB

9,654 KB

7,863 KB

8,534 KB

8,371 KB

10,875 KB

10,343 KB

9,068 KB

11,923 KB

9,348 KB

12,802 KB

8,008 KB

9,290 KB

11,500 KB

9,064 KB

9,936 KB

9,763 KB

7,155 KB

10,516 KB

10,459 KB

9,834 KB

Exposure time
1/60 sec.

1/40 sec.
1/50 sec.
1/160 sec.
1/30 sec.
1/60 sec.
1/40 sec.
1/80 sec.
1/80 sec.
1/60 sec.
1/80 sec.
1/100 sec.
1/60 sec.
1/50 sec.
1/80 sec.
1/40 sec.
1/60 sec.
1/30 sec.
1/60 sec.
1/40 sec.
1/160 sec.

1/125 sec.

Focal length
18 mm

18 mm
18 mm
18 mm
21 mm
37 mm
25 mm
55 mm
18 mm
18 mm
18 mm
18 mm
37 mm
24 mm
18 mm
18 mm
40 mm
18 mm
32 mm
18 mm
34 mm

24 mm

F-stop
f/5

/4
/4.5
/7.1
3.5
/4.5
/4

/5.6
/5

/5

/5.6
/6.3
/4.5
/5

/5.6
£/3.5
/5

£/3.5
/4.5
3.5
/8

f/8



Clearly when we save a document or other file, it is better to save it in a location whence we can easily retrieve
it when we need it. Unfortunately Windows and other programmes often have their own views on where to
store a file and care needs to be taken when first saving any file. Ensure that you have given the file an
appropriate name and checked that the file location is correct BEFORE clicking “Save”.

The screenshot below shows how Word reacts when you click on “Save” for a brand new document.

Save As The second column from the left
(1) et i lists high level options, while the
Today third column shows a few folders
OneDrive - Personal America 12 take 2 07/06/2022 08:16
‘ turkishjim@hotmail.com E‘ Documents » Holidays » America 12 take 2 you have used recently.
ER. oo s If you want to save the document
D adda sce R in a folder which is not listed, you
PTVM 06/06/2022 13:39 .
£ browse 3 e should click on “Browse” to
E‘ Downloads 06/06/2022 13:16 . . .
navigate to the desired location.
D U3A . 06/06/2022 12:44
Last Week

E‘ temporary 30/05/2022 14:56
Documents » Business » temporary



When you have selected the appropriate location, the screen will look like this:

Document1 - Word

© Save As
Gu Home
T = Documents > Business > temporary
B @ Recent | Enter file name here |
& Open P | Word Document (*.docx) - @

More options...
. OneDrive - Personal

Info turkishjim@hotmail.com D New Folder
Other locations.
Save = Name T Date modified
E@ This PC
Save As
) _@ Add a Place . -~
Print D Bing 17/01/2021 21:51
Share . Browse
E’ FCMag ad 17/01/2021 21:51
Export
T ] miscellaneous 01/02/2022 21:23
Close
I::| New folder 01/06/2022 16:01
| e,

You need to enter the name of your document in the field near the top of the screen (outlined in red above). Note
that Office applications, in particular Word, sometimes decide that the first few words in the document are also the
title. In that case the field will be pre-populated and you may need to change the name.



THE END

©2022 Jim Morrison



